YASKAWA Electric Corporation
Machine Controller MP900 Series

Ethernet Driver

Supported version TOP Design Studio V1.0 or higher {Rl

TOP

"

CONTENTS

We would like to thank our customers for using M2l's "Touch

Operation Panel (M2l TOP) Series". Read this manual and familiarize
yourself with the connection method and procedures of the "TOP and

external device".

1. System configuration Page 2

Describes the devices required for connection, the setting of

each device, cables, and configurable systems.

2. External device selection Page 3

Select a TOP model and an external device.

3. TOP communication setting Page 4

Describes how to set the TOP communication.

4. External device setting Page 10

Describes how to set up communication for external devices.

5. Supported addresses Page 13

Refer to this section to check the addresses which can

communicate with an external device.
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1. System configuration

The system configuration of TOP and "YASKAWA Electric Corporation — MP900 Series Ethernet” is as follows:

Communication

Series Link I/F System setting
method

Eth t Port 3. TOP communication g "
ernet For Twist .
MP900 MP920 Ethernet(TCP/UDP) setting wisted pair cable

on 218IF-01 ; ) *Note 1)
4. External device setting

*Note 1) Twisted pair cable
- Refer to STP (Shielded Twisted Pair Cable) or UTP (Unshielded Twisted Pair Cable) Category 3, 4, 5.
- Depending on the network configuration, you can connect to components such as the hub and transceiver, and in this case, use a

direct cable.

W Connectable configuration
+ 1:1 connection (one TOP and one external device) connection

] [UINE -

— | HUB '

* 1:N connection (one TOP and multiple external devices) connection

D m*: M*F ......... 1 "'E

| HUB |—
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2. External device selection

H Select a TOP model and a port, and then select an external device.

Select Device [ = |

PLC select [Ethernet]

Filter : [ pail ~] Search
@ Model () Vendor

Vendor
M2I Corporation [l
MITSUBISHI Electric C i

lectric Corporation & Mp2000
OMRON Industrial Automation

Mp3000
LS Industrial Systems
& High Speed Ethernet Server

MODBUS Organization
& SR100

SIEMEMS AG.

Rockwell Automation

GE Fanuc Automation

PANASONIC Electric Works

YASKAWA Electric Corporation

YOKOGAWA Electric Corparation

Schneider Electric Industries

KDT Systems
RS Automation h
4 Eack | B Next ® Cancel
Select Device H
PLC Setting[ Mp900 ]
Alias Name ; |PLC1 BindIP: lAuto v
Interface : |Ethernet ~
Protocol : |Extended Memobus RTU ~ ~ Comm Manual

String Save Mode @ |First LH HL Change

[] use Redundancy
AND 4

Primary Option

g ‘192 :| ‘168 :| ‘EI :‘ |1 -

Ethernet Protocol

Timeout - msec
Send Wait - msec
HMI Port m

@ Back v oK ® Cancel
Settings Contents
TOP Model Check the TOP display and process to select the touch model.
External device | Vendor Select the vendor of the external device to be connected to TOP.

Please select "YASKAWA Electric Corporation".

PLC Select the external device to be connected to the TOP.

Interface Protocol

MP900 Series Ethernet Set Users

Supported Protocol
Extended MEMOBUS RTU Extended MEMOBUS ASCII

Please check the system configuration in Chapter 1 to see if the external device you want to

connect is a model whose system can be configured.
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3. TOP communication setting

The communication can be set in TOP Design Studio or TOP main menu. The communication should be set in the same way as that

of the external device.

3.1 Communication setting in TOP Design Studio

(1) Communication interface setting
M [ Project > Project Property > TOP Setting ] — [ Project Options > "Use HMI Setup” Check > Edit > Ethernet]

— Set the TOP communication interface in TOP Design Studio.

Project Option X
-Change HMIH] ‘Md PLC(Al | T Change PO ] Delete PLCID]
oL SEt‘:j”g o Date / Time Sync. | Screen Option  Unit Convert
:Eﬁ;'_”g;d“'é)sem"g Project Option | Screen Change | HmiSetup | Global Lock & Touch || Project Style | Splash | PLC Buffer Sync.
7 & RFID (0) Use HMI Setup
M ‘?’ETEZ;T‘EQ)Q kS e ey Initialization | Edit |
5% COM2 (0) Project Setting ~
-1g® COM3 (0) HMIDisable =0
v Ethernet (1) Project Nam_e =New project
Lgp wreea fit S
L. USBDevice (0) Latch Set=0~0
Communication Error Message=0
USBErrorMessage =0
StorageErrorMessage=1
DatabaseMessage=1
Control Fanel
P ) X
System Devices @ Ethemet X
-Port
B P | e Ethernet Port :{ETH1 ~|0 -
Ul l ? i Link Speed : Auto -
FLC Security Date/Time MAC Address @ 00:00:00:00:00:00
IP Address :|  192.168.0.50
Subnet Mask :|  255.255.255.0
o @ © E.:) Gateway | 182 .168.0.1
III"" Default Gateway
Et hernet Serial HOM | DNS (17 ¢
DNS (2) ¢
— % -Ethernet
= ) Primary IP : | 192.168.0,50 =
L A . Ping
Diagnost ic File Fing Cable Status
Manager Bridage Mode : [ Use Bridge
Check duplicate | Apply || Cancel
Items TOP External device Remarks
IP Address*Note 1) Note 2) 192.168.0.50 192.168.0.51
Subnet Mask 255.255.255.0 255.255.255.0
Gateway 192.168.0.1 192.168.0.1
*Note 1) The network addresses of the TOP and the external device (the first three digits of the IR, 192 . 168 . 0 . 0) should match.
*Note 2) Do not use duplicate IP addresses over the same network.
* The above settings are examples recommended by the company.
Items Description
IP Address Set an IP address to be used by the TOP to use over the network.
Subnet Mask Enter the subnet mask of the network.
Gateway Enter the gateway of the network.
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(2) Communication option setting

M [ Project > Project Property > PLC Settings > ETHERNET > “PLC1 : Mp900"]
— Set the options of the MP900 Series Ethernet communication driver in TOP Design Studio.

ERI2 e B X
Touch Qperation Panel

Project Option

- Change HMI[H]

W Acd PLC Al Tl Change PLCIC)

[ Delete PLCID)

~ ] TOFP Setting
| L[ 5Y5:RD1520%

Option Module Setting
B FieldBus (0)

4§ USBDevice (0)

PLC Setting[ Mp900 ]

Alizs Name : [PLC1 BndIP: Auts

Interface : |Ethernet ~

Protocol : |Extended Memobus RTU ~
String Save Mode : (First LH HL Change

[] use Redundancy

AND w
. -
= hd
Conditior Edi
Primary Option
P [2 | 68 B0 FH [ F
Ethernet Protocol TCP v

Port 1024 z

Timeout

HMI Port 1025 -

Send Wait msec

Comm Manual

Apply Close

* The above settings are examples recommended by the company.
Items Settings Remarks
Interface Select “Ethernet”. Refer to "2. External
Protocol Select the communication protocol between the TOP and an external device. device selection”.
IP Enter the IP address of the external device.

Ethernet Protocol

Select the Ethernet protocol between the TOP and an external device.

Port

Enter the Ethernet communication port number of an external device.

TimeOut (ms)

Set the time for the TOP to wait for a response from an external device.

SendWait (ms)

Set the waiting time between TOP's receiving a response from an external

device and sending the next command request.

HMI Port

Enter the Ethernet communication port number of the TOP.
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3.2. Communication setting in TOP

* This is a setting method when "Use HMI Setup” in the setting items in "3.1 TOP Design Studio” is not checked.

W Touch the top of the TOP screen and drag it down. Touch “EXIT" in the pop-up window to go to the main screen.

(1) Communication interface setting

B [ Main Screen > Control Panel > Ethernet]

"ﬁ. Ethernet

Run

YNC
Yiewer

@ System rPort Dpt ion
Ethernet Port :| ETHI |~/ 0 |+
! Link Seeed :| Auto M j‘))
L MAC Address : 00:15:10:05:38:C5
PLE | IP Address :[  192.168.0.50 sound
Subnet Mask :[ 255.255.255.0

= Gateway :|  192.168.0.1 o —
I “ B Default Gateway '~
Ethernet ODWS €13 ;|
| DNS (2) ] .
m Bl . Fthernet m
U Prinary 1p [ 192.168.0.50 .l
Diagnost ic MRAM
Cable Status ETH1 Connected Analysis
Bridge Mode : [ Use Bridge
[System] lCheck dup | icate] [ A [ I Cancel ]

o |

Items TOP External device Remarks
IP Address*Note 1) Note 2) 192.168.0.50 192.168.0.51
Subnet Mask 255.255.255.0 255.255.255.0
Gateway 192.168.0.1 192.168.0.1
*Note 1) The network addresses of the TOP and the external device (the first three digits of the IP 192 . 168 . 0 . 0) should match.
*Note 2) Do not use duplicate IP addresses over the same network.
* The above settings are examples recommended by the company.
Items Description
IP Address Set an IP address to be used by the TOP to use over the network.
Subnet Mask Enter the subnet mask of the network.
Gateway Enter the gateway of the network.
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(2) Communication option setting
M [ Main Screen > Control Panel > PLC ]
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®

@ Systen Driver(ETH) | PLCI(MpA00) ||
B
i Interface [ Ethernst |']
m Protocol [ Extended Memobus RT|']
PLE Bind IP [Auto [~]
WHE Ip (1925 8l [0 [ (31 [
LR m Ethernet TGP |+
- . u
:ﬁ Ethornet Port 1024 5
L Timeout 1000 |5 msec
LN BN
- m zend Wait msec
S HMI Port 1025 |2
Diagnost ic
[Svstem] [ Diagnostic HDing Tesfl

* The above settings are examples recommended by the company.

Items Settings Remarks

Interface Select “Ethernet”. Refer to "2. External
Protocol Select the communication protocol between the TOP and an external device. device selection”.
IP Enter the IP address of the external device.

Ethernet Protocol

Select the Ethernet protocol between the TOP and an external device.

Port

Enter the Ethernet communication port number of an external device.

TimeOut (ms)

Set the time for the TOP to wait for a response from an external device.

SendWait (ms)

Set the waiting time between TOP's receiving a response from an external

device and sending the next command request.

HMI Port

Enter the Ethernet communication port number of the TOP

External device connection manual for TOP Design Studio
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3.3 Communication diagnostics

B Check the interface setting status between the TOP and an external device.
- Touch the top of the TOP screen and drag it down. Touch "EXIT" in the pop-up window to go to the main screen.
- Check if the port (ETH1/ETH2) settings you want to use in [Control Panel > Ethernet] are the same as those of the external device.

W Diagnosis of whether the port communication is normal or not
- Touch “Communication diagnostics” in [Control Panel > PLC ].

- The Diagnostics dialog box pops up on the screen and determines the diagnostic status.

oK Communication setting normal

Time Out Error Communication setting abnormal

- Check the cable, TOP, and external device setting status. (Reference: Communication diagnostics sheet)

B Communication diagnostics sheet

- If there is a problem with the communication connection with an external terminal, please check the settings in the sheet below.

Items Contents Check Remarks
System How to connect the system OK NG ) )
configuration Connection cable name OK NG 1. System configuration
TOP Version information oK NG
Port in use oK NG
Driver name OK NG
Other detailed settings oK NG
Relative prefix Project setting oK NG 2. External device selection
Communication 3. Communication setting
diagnostics oK NG
Ethernet port setting IP Address oK NG
Subnet Mask oK NG
Gateway OK NG
External device CPU name oK NG
Communication port name (module name) OK NG
Protocol (mode) OK NG
Setup Prefix OK NG ) )
Other detailed settings oK NG 4. External device setting
Ethernet port setting IP Address oK NG
Subnet Mask oK NG
Gateway OK NG
Check address range 5. Supported addresses
OK NG (For details, please refer to the PLC
vendor's manual.)
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4. External device setting

4.1 Extended MEMOBUS - 218IF-01/02

Set as below using "MP Series” Ladder Software "MPE720". For more detailed setting method than that described in this example,

refer to the PLC user manual.

A Do not use duplicate IP addresses over the same network.

[ ] Operation I : "PC and PLC connection method" : set communications as follows(Operation II, Operation II), but before
connect PC and PLC.

1. Run "Communication Manager" program.

( Path : Start — Program — "YE_Applications” — “Communication Manager” )

2. Run "Logical Port Setting" to set the port type and details.
( Path : File — Setting...)

3. After PC and PLC are connected, save, and follow below operation.

[ ] Operation II : "MPE720" Create Project : (root) > [Group Folder] > [Order Folder] > [Controller Folder] Register

1. To register the device you want to use in “MPE720", follow “[Group Folder] > [E-gg (root)
- NEWPRJ
[Order Folder] > [Controller Folder]” path. [;ID TESTI
(Caution) In the "MPE720" left project window, Right—Click, =i MPz000
+-(_] C Register Folder
and follow the parent path through the [New] entry. + (1] Database

-2 Definition Falder

2.Register the Controller Type for the device you wish to use in the Controller spplication Infarmation Seting

Configuration window, which appears when registering a new [Controller Folder] Data Trace
Module Configuration
3. Double-click the newly registered [Controller Folder] to bring up the [Log on scan Time Setting
. . Systern Configuration
to the controller] window and enter "User Name" and "Password" to form project (23 Programs
folders as shown on the left. +-(] Table Data Folder

H Operation III : “Communication Setting” : [Engineering Manager] — [Module Configuration] window
1. [Definition Folder] — [Module Configuration] double click to bring up [Engineering Manager] — [Module Configuration] window.
2. In the Module Configuration window, register the appropriate [Rack] — [Slot] location [Module Type].

3. Double-click the appropriate [Slot Number] to display the Settings window. The information to be set is as follows.
Transmission Parameters ] Status ]

CP-218 Transmission Parameters
Station Setting

IP Address e =, e [0 = . |51 = (0-255)
MEMOBUS Setting
Responze Time @ [0 = s (0-2557)
Caount of Retry Con =] time {(0-258)
CP-Z218 Connection Parameter
ON | ‘55l | Node 1P Address | Mode | Conect Pigecel Gode M
01 01024 | 192.168.000.050 no2s TGP _v |Extended MEMOBUS  « [BIN |
02 |-—- - - -
Items Settings Remarks
Transmission parameter Station Setting IP Address 192.168.0.51 PLC IP address
Connection parameter Local Port 1024 PLC Port number
Node IP Address 192.168.0.50 HMI IP Address
Node Port 1025 HMI Port Number
Connect Type TCP Set Users
Protocol Type Extended MEMOBUS Fixed
Follow protocol
Code BIN RTU : Select BIN
ASCII: Select ASCII
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1. Register the [MSG-RCV] function ([Instruction Pallet] menu - [System] tab]) into the [Ladder Works] Software, referring to the

example below. Refer to the Ladder Software manual for more information. (¢Caution: Set the value of [Dev-Type] to "6" for 218IF-

01 and "218IF-02 to "16".)

First scan after startup

A

—C IF
SBO00001==true

—( FOR }

wariable |

Init 00000
Max 00031
Step 0ooo1

—( STORE ¥
Source 00000
Dest  DW0DDOD

—{(END FOR)

— STORE ¥
Source 00001
Dest  DW0O00D02

— STORE ¥

Source 00000
Dest  DWO0OODDDA

— STORE ),
Source 00000
Dest DWWoooos

— STORE ¥
Source 00000
Dest  DWO0OOD10

—( STORE )

Source 00000
Dest OWooo

— STORE ¥
Source 00000
Dest owWoon12

—( STORE 5
Source 0000085534
Dest  DW0OODD13

END_IF Stop MNormal Abnormal

command  completion completion
SBDIC'?GU“ DIB{J{10202 DBOD0211 IZIJE}ll]D{1212

| A

[ I Gl L]

—( MSG-RCY D)

Excute DBO0DZ01 Busy DBO00210
Abort DBOOOZ02 Complete DBO00211
Dev-Typ 00006 Emor DBO00D212

Pro-Typ 00001
Cir-No 00001
Ch-No 00001
Param DADQDDD

MNormal completion

IF 3
DB000Z11==true

INC
Dest  DWOO0024

— (END_IF

Abnormal completion

— IF 3

DB000212==tue

—C_INc D

Dest  DWOO0O025

—( STORE }

Source DWO0000
Dest DWO0026

_E STORE )

Source  DWO0OD0O01
Dest DwWoDoz7

END_IF

)

END

External device connection manual for TOP Design Studio

Sets parameters in the first scan after startup.
{Low-speed scan (DWG L): SB000003
High-speed scan (DWG H): SB0O00001)

Clears DWS registers to zero.

Sets the connection number.

Sets the coil offsel

Sets the input relay offset.

Sets the input register offset.

Sets the holding register offset.

Wright range: LO

Wright range: HI

Starts receiving

The BUSY coil terns ON when the CPU

receives a command.

The COMPLETE or ERROR coil turns ON at

the completion of processing.

Set Pro-Typ = 1 for Extended MEMOBUS or MELSEC.

Set ch-No = The same numerical value as source of
connection number setting (fourth ling).

Mormal completion

Abnormal completion

Stores the processing results.

Stores the status.
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4.2 Extended MEMOBUS - CPU Built-in Ethernet Port

Set as below using "MP Series” Ladder Software "MPE720". For more detailed setting method than that described in this example,

refer to the PLC user manual.

A Do not use duplicate IP addresses over the same network.

[ ] Operation I : "PC and PLC connection method" : set communications as follows(Operation II, Operation II), but before
connect PC and PLC.

1. Run “Communication Manager” program.

( Path : Start — Program — "YE_Applications” — “Communication Manager” )

2. Run "Logical Port Setting" to set the port type and details.
( Path : File — Setting... )

3. After PC and PLC are connected, save, and follow below operation.

[ ] Operation IT : "MPE720" Create Project : (root) > [Group Folder] > [Order Folder] > [Controller Folder] Register

1. To register the device you want to use in "MPE720", follow “[Group Folder] > =gy (root]
= MEWFRJ
[Order Folder] > [Controller Folder]” path. ll:lD TESTI
(Caution) In the "MPE720" left project window, Right—Click, =-{ilil MPZ000
+-[C] C Register Folder
and follow the parent path through the [New] entry. -] Database

—-(L1 Definition Folder

2.Register the Controller Type for the device you wish to use in the Controller Application Information Setting

Configuration window, which appears when registering a new [Controller Folder] Data Trace
Module Configuration
3. Double-click the newly registered [Controller Folder] to bring up the [Log on Scan Time Setting
. . Systern Configuration
to the controller] window and enter "User Name" and "Password" to form project . Programs
folders as shown on the left. +-(] Table Data Folder

H Operation III : “Communication Setting” : [Engineering Manager] — [Module Configuration] window
1. [Definition Folder] — [Module Configuration] double click to bring up [Engineering Manager] — [Module Configuration] window.
2. In the Module Configuration window, register the appropriate [Rack] — [Slot] location [Module Type].

3. Double-click the [Slot Number] which the Ethernet UNIT is connected to display the Settings window.[Transmission Parameter]

tabsettings information is as follows.

Items Settings Remarks
IP Address 192.168.0.51 PLC IP address
Subnet Mask 255.255.255.0 PLC Subnet Mask

4. From [Transmission Parameter] tab — click [Easy Setting], in [Message Communication Easy Setting] window set as follows, Click

"OK" to save settings information.

Items Settings Remarks
MP Series Port No. 1024 PLC Port number
Communication protocol Type Extended MEMOBUS Fixed
Connect type TCP Set Users
Follow protocol
Code BIN RTU : Select BIN
ASCII: Select ASCII
Node Port IP Address 192.168.0.50 HMI IP Address
Other Device Port No. 1025 HMI Port Number

5. Double-click [Setting] to set [Automatically Accepted] to "Enable” in the [Automatically Accepted Setting] window and save the
settings by clicking “OK".
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5. Supported addresses

The devices available in TOP are as follows:

The device range (address) may differ depending on the CPU module series/type. The TOP series supports the maximum address
range used by the external device series. Please refer to each CPU module user manual and be take caution to not deviate from the
address range supported by the device you want to use.

Device Bit Address Word Address 32bit Remarks
MB Coil MBO000000 ~ MB65535F MBO00000 ~ MB65535 L/H

B Discrete Input IBOO00O ~ IBFFFFF IBOO0OO ~ IBFFFF *Note 1)
W Input Register - IW0000 ~ IWFFFF *Note 1)
MW Holding Register - MWO00000 ~ MW65535

*Note 1) Cannot be written
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